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What's New in Lyric v5.0? 
Please visit http://www.chyron.com/support/, and then 
click on Documentation > Duet Family > Lyric Online 
Help for the latest update to Lyric Help. 

Updated August 26, 2004 

New Features 

 Backup & Restore:  Provides a convenient way to backup assets associated with a Browser or Directory 
and move these to another system.  Backup collects assets (bitmaps, messages, TrueType® Fonts, etc.) 
into user-specified folders.  Restore allows specification of folder locations for each asset type. Accessed 
from the Lyric File menu. 

 Soft Masks (Duet LE/LEX/PCI/PCI+ Only):  Accessed from the context (right-click) menu for the object in the 
Scene Graph or Canvas. 

 Center of Rotation can now be displayed on an object.  Accessed from the context (right-click) menu for the 
object in the Scene Graph or Canvas. 

 3D Canvas Scene Views  (XY, YZ, XZ,  Perspective):  In addition to the normal Lyric Front view, the 
Canvas now has Top, Perspective, Left and Multi views available.  Two related preferences:  Show 
Viewport Labels in CG Preferences, and Lock Viewport Sizes in Windows Preferences.  Preferences 
are accessed from the Lyric Config menu.  A Multi View on/off toggle is also available from the View menu. 

 New internal clip player hardware supports multi-channel clip playout.  Clear Output button has been 
added to the Clip Control Panel.  Also, pressing Ctrl + Alt + Q (PC keyboard) or Alt + Erase (Duet 
keyboard) can clear the current clip player channel and frame buffer output.  The following should be noted: 

o The minimum offset of a clip on the Timeline is 3 frames.  Anything less than 3 frames is ignored, 
and treated as if set to 0 frames. 

o The minimum number of frames that can be looped to from the end of a clip is 15.  Output is 
unpredictable if the loop frame is set to less than 15 frames from the end of the clip. 

o Default Operation Selection:  The first frame of a clip is not displayed in output when a message 
containing a clip is loaded.  When the message is executed, the clip starts playing and is then visible 
on output. 

 To change default behavior so that the first frame of the clip is displayed on output when the 
message is read, navigate to file in which Lyric is installed.  Double-click on the file 
DisableMatroxSourceSwitcher.reg.  Displaying the first frame of the clip was the default 
behavior of messages read in versions of Lyric predating Lyric v5.0.  Note that clips 
contained in messages created in these earlier versions behave according to the current 
default setting in Lyric v5.0 when read. 

 To revert back to the default behavior for Lyric v5.0, navigate to file in which Lyric is installed, 
and then double-click on the file EnableMatroxSourceSwitcher.reg. 

Refer to What's New in Lyric v4.14? and What's New in Lyric v4.15? for additional information on clip 
player enhancements.   Refer also to Internal Clip Control Player and Clip Control Panel for detailed 
information on clip operation.  Note that the content in these two sections is superceded by the enhancements 
in the release notes. 

 New Advanced Image Effects have been added:  Assemble/Disassemble; Flipboard; Crumble; 
Detonate; Flag; Bulge (Duet LEX/PCI+ only); and Globe (Duet LEX/PCI+ only). 
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 Motion Path:  A Motion Path can be displayed for any 2D bitmap, 3D character or 3D object that contains 
more than one keyframe.  The Motion Path is accessed from the context (right-click) menu for the object in 
the Scene Graph or Canvas. 

 Rendering performance has been improved on Duet LEX/PCI+ systems.  

 Movie Objects:  Adds the ability to import AVI or Quicktime movie files (RGB only) into the scene as 
animatable objects.  Image Effects can be applied to Movie object. 

 Scene Graph:  Objects in the Scene Graph can now be color-coded.  The text/highlight color in the Scene 
Graph for an object can be changed from the context (right-click) menu for the object in the Scene Graph or 
Canvas. 

 Animation Rate:  Can now maintain the animation rate (i.e., the number of characters displayed per second) 
by automatically modifying the animation in a Type On, Roll, or Crawl window.  This feature is accessed from 
the Animation tab of the Properties window, and is made active by enabling the Speed or Rate buttons. 

 Keyframe All Objects and Keyframe Selected Objects on the Edit menu now include all applicable 
attributes for each object. 

 The Font Sample chip in the Font Properties and 2D Font FX Properties tabs and on the 2D Text 
Template dialog box is now red-slashed if the TrueType Font is not available. 

 Playlist:  New features have been added to the Playlist: 

o The Playlist Configuration dialog has been expanded to include GPI triggers for Line Up and Line 
Down. 

o Default Playlist Attributes. 

o Scroll Offset. 

o Preview Options. 

o Cue Clip.  Cue Clip was moved from the Control column of the Playlist. 

 Read Next mode is now maintained per frame buffer.  That is, changing to a different frame buffer no longer 
clears the Read Next status of the inactive frame buffer.  Read Next is still in force when the original frame 
buffer is reactivated. 

 Advanced Image Effects now keeps the object on screen based on the duration of the object on the 
Timeline, not the duration of the effect. 

 GPI Pauses are now supported for nonstop Flipbook animations on Duet LE/LEX/PCI/PCI+ systems. 

 Enhancements to Selective Recording (Ctrl + Record): 

o Record a Template Data Message from within Lyric:  Multiple Template Data Messages can 
reference the same Template Description Message and therefore the format of all Template Data 
Messages can be changed by simply modifying the underlying Template Description Message. 

o Preview Frame:  Specify which frame should be shown in VGA (Canvas) preview if this preference 
is enabled. 

o Embedded Macro:  Embed a macro in a message.  The macro auto-executes when the message is 
read. 

o Ctrl + Alt + Record:  New accelerator key combination added to selectively record (Ctrl + Record) to 
the same message number as that loaded in Canvas. 

 The Load, Quick Load, Load Saved, Save, Stop and Play icons have been removed from the Duet 
LE/LEX/PCI/PCI+ Tools toolbar.  Load (Alt + L), Quick Load (Alt + Q), Stop (Esc) and Play (Alt + Y) 
functionality are still available from the accelerator keys as noted above.  The Save and Load Saved 
functions have been removed. 
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 Changes to display priority via drag-and-drop in the Scene Graph view are now possible even if a group is 
present.  Drag-and-drop within a group is also now supported.  To facilitate these changes, a group added to 
a new message will now dictate display priority of all its members of equal Z value.  This is enabled/disabled 
via Use Group Priority, accessed from the context (right-click) menu for the object in the Scene Graph or 
Canvas, and then selecting Internal Properties. 

 Texture compression is now supported for Flipbooks and 2D Bitmaps. An nVIDIA® GeForce FX or better 
board is required.  Duet LE/LEX/PCI/PCI+ systems will be able to create and record messages which have 
compressed Flipbooks/2D bitmaps.  Duet SD systems will be able to read messages with compressed 
Flipbooks but will uncompress them before playback.  Using compressed textures will speed up message 
Read and Record. 

 Advanced Text Effects:  Duration of an Advanced Text Effect will now automatically increase when 
necessary so that effect can be completed on all applicable elements of the 2D Text Window.   This 
adjustment is applied only when configuring the effect. 

 Clocks/Timers: 

o Support new clock/timer format specifier –0 which will strip the leading zero off of such formats as 
h:mm, causing timer to display :59 instead of 0:59 

o Allow clocks/timers to support justification to prevent digits from moving to the left when the new 
format above is used. 

 Message Record and Delete information on the Status Bar is now more prominently displayed with a green 
background. 

 A particular surface on a 3D object can now be selected with the mouse.   Reflective, Masked or neither can 
now be set in Properties > Surface for each individual surface. 

 Graphic Import: 

o Import Graphic now supports the import of 32-bit Photoshop, PNG and LZW files. 

o The Import Graphic dialog now has a Merge Layers checkbox for Photoshop files.  If not selected 
(checked), each layer in the Photoshop file is imported as a separate image, and is displayed as such 
in the Scene Graph. 

 An animation on a Duet LE/PCI system now plays out to scene Duration instead of the length of the Camera 
Timeline. 

 Paste Unicode Text now immediately adjusts to existing Row Tabs. 

 A variety of Internal Properties can now be set per object or per message.  Internal Object Properties can 
be accessed from the 2D Text Window, 2D object, 3D character and 3D object context (right-click) 
menus.  Internal Message Properties can be accessed from the Light, Global Light and Camera context 
(right-click) menus.  Internal Message Properties can also be accessed from Tools Menu > Set Message 
Properties.  
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 The Config Menu > Duet Hardware > Setup Board Configuration tab has been reformatted.  The Video 
Insert/Video Only controls are no longer present; Video Insert is always set.  If you wish to disable the 
graphics layer, you should instead erase the frame buffer.  NOTE: Certain configuration settings have been 
deprecated in the registry.  Therefore, if you attempt to go back to a previous version of Lyric after using this 
version, you may need to reset the Video Standard, Genlock, and Video Insert settings for each board in 
the system. 

 

 Chinese, Japanese, and Korean 2D and 3D text input to the Canvas is now supported.  Also support 
Template Update and Spline Edit Window for these languages.  Note that Unicode Only must be selected 
(checked) in the CG Preferences to enable Asian language support.  CG Preferences is accessed from 
Config Menu > Preferences. 

 Analog Lantern 64 PCI cards are now supported.  Configuration of Analog cards is subject to certain 
limitations:  Video In layer cannot be turned off; Video Out cannot be delayed horizontally or vertically; and 
Ancillary Data settings cannot be modified. 

 When reading a Template Data Message (Intelligent Interface W file), the Template Description Message 
will now be read from the same directory (i.e., the Intelligent Interface directory, if read by Intelligent 
Interface).  This directory is also the Default Message Directory, which is set from Config Menu > 
Preferences > Default Paths.  The Intelligent Interface Message Directory path can also be viewed from 
Config Menu > Intelligent Interface. 

 Ctrl + Tab in 2D Text Windows are now supported in pasting, Template Update and DBLink. 

 New compositing (i.e., blend) modes are now supported in the Animation Settings Preferences: 

o Fast:  Produces fastest rendering times, but sacrifices quality on overlapping transparent pixels. 

o Normal:  Accurate compositing of transparent overlapping pixels, but slower render times than 
Fast.  Also requires GeForce FX or better VGA card. 

o Depth (2 Pass):  Accurate compositing of intersecting transparent objects, but yields slowest 
rendering times. 

o Fast/Fix Key:  Fast rendering plus improved alpha blending for overlapping transparent pixels and 
Key signal. 
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 Macros/LEIF Additions and Modifications:  

o Font on Text object is now settable, i.e., the default font for a 2D Text Template can be changed 
from a macro/plugin. 

o Calling the Update method on a Font object will now apply changes to selected characters as well as 
update active font. 

o Calling the Load method on an Image object with an empty string for the filename will cause the 
Graphic Import dialog to pop up. 

o Added RemovePreMultiply property to Image object. 

o A new method IICommand on Lyric object will accept and process an Intelligent Interface 
command. 

o New Surface object for 3D characters/objects allows get/set color and texture filename. 

o Enhanced Row object to support retrieval of text, font, character position, etc. 

o If Globals have been entered in the Globals tab of the Macros dialog box, Save Globals in the 
Save Macros To dialog box is automatically selected (checked). 

o The hotkey for a macro is not displayed if there was a failure to register the macro. 

o The maximum length of an auto-recorded macro statement has been increased from 256 bytes to 2K. 

o Added method NextTemplate on Template object to return the next template in numerical sequence. 

o Added Move method to Image and Template objects. 

o Added method Message to Scene object to return the message number of the current scene.  This 
will be accurate on read and record, while Lyric.Message is not. 

o Added MessagePath property to Lyric object to get/set the preferred message path. 
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Bug Fixes 

 Resolved problem where a Template field was auto-erased erroneously when reading a 
Template Data Message (W file) which contained fewer updates than were Templates 
available. 

 Resolved color-caching issue when the font edge was changed from a file-based texture 
to a gradated texture. 

 Clocks/Timers: 

o Corrected resource leak occurring on change of format string (Duet LE/PCI only). 

o Synchronized Clock/Timer display with Lyric objects on transfer to Duet 
LEX/PCI+ output. 

o All Clocks/Timers on Duet SD output are now stopped if an animation error 
occurs with any one of them. 

 Duet LEX/PCI+ Video setting is now maintained upon exit from Lyric.  

 Resolved problem where an Advanced Image Effect would not execute once the image 
was updated through DBLink. 

 Resolved a resource leak occurring during Playlist execution on Duet LEX/PCI+. 

 Resolved issues related to soft Type On for Duet SD and Duet LE/LEX/PCI/PCI+. 

 If 2D Frames On is selected from the selected 2D Text Window context (right-click) 
menu, all frames of selected text windows are toggled on/off.  Previously, only the last-
selected 2D Text Window was toggled. 

 Resolved incorrect sort order in message entries generated by a Browser Search. 

 Intelligent Interface: 

o An animation read up via a Y command on a Duet LE/PCI system can now be 
played to the active output frame buffer with a subsequent Y or V command. 

o Diagnostics section in Intelligent Interface dialog box (accessed from Config 
Menu > Intelligent Interface) will now update if connected over Telnet. 

o Telnet and Recall Keys options are now prevented from being selected 
simultaneously in the Intelligent Interface dialog box (accessed from Config 
Menu > Intelligent Interface). 

o The Recall Keypad display will now report Invalid Message if a Read or Read 
Next fails to load a message.  This problem existed on Duet LE/PCI only. 

 Masks: 

o Resolved intermittent issue with surface transparency of 2D Text Windows if 
they render after a Mask object. 

o Resolved blending problems with other characters in a 2D Text Window in which 
a Mask Character was present. 

 Resolved scaling issue with the first character in an animated 2D Text Template if it was 
located near the 2D Text Template boundary 
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 Playlist and keyframe pauses for GPI now function correctly when RS-422 Serial I/O & 
GPI/O Board was installed in a Duet LE/PCI system. 

 Resolved flash on Duet SD output if mixer was reset to default when either Output Layer 
was set for mix 

 Resolved intermittent problem where text would not appear on Duet SD output if the 
containing 2D Text Template had a background. 

 Resolved problem where characters would be missing from a 2D Text Window after an 
extended period of constant updating. 

 Corrected Timeline length of group members when Apply All was executed from 
Animation Properties. 

 Resolved problem with iNFiNiT! batch export on Duet LE/PCI, where missing Message 
Numbers within the specified range were still exported.  They contained content from last 
available message. 

 Corrected Auto Standards Conversion bug, where 16:9 message was not properly 
scaled when read into a 4:3 Canvas. 

 Resolved problem where an iNFiNiT! character was replaced via Sync TrueType Fonts 
if it had been imported into a 2D Text Window in which a Browser font was active. 

 Corrected screen position of 2D Text Windows that had Xscale/Yscale/Zscale 
keyframes. 

 Ensured the availability of font assets in the Browser is updated when read from the 
database file.  Previously, only those font assets visible in the Font Browser Window 
were checked.  As a result, Sync TrueType Fonts could update characters to a non-
existent font. 

 Resolved problem where Key Input and Shape settings for the SD Mixer were not being 
saved for a Timeline mix if offline. 

 Reload of image data during message read (e.g., for non-embedded, interfaced or 
DBLinked images) will no longer make the image visible if it is not. 

 Resolved crash occurring if a larger font was applied to a 2D Text Template with Word 
Wrap enabled 

 Corrected operation of Aprisa VCS if Use Channel B was selected. 

 Corrected problem in reading pop-on messages, where characters would be added, but 
then deleted when subsequent characters were inserted out of sequence on the same 
row. 

 Plug texture memory leak on successive video captures on LE 

 Template data messages read through Intelligent Interface will now use the Intelligent 
Interface message directory 

 Corrected Duet LEX/PCI+ video settings for Video Key enable not being stored/restored 
from registry correctly. 
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 Internal Clip Player: 

o An internal clip will no longer start prematurely on Duet LE/PCI systems if the 
animation is paused at frame 0. 

o Resolved problem where internal clip added after audio clip would not have 
visible video. 

o Resolved problem where a clip would not play if read up twice while another 
looping clip was playing on output. 

o Resolved problems with using clips from two channels in same frame buffer 

 GPIO on Duet LE/PCI systems 

o Resolved problem where a GPI used to release a pause could not be used for 
any other purpose (i.e. as a global GPI) without restarting Lyric. 

o All available GPIs are now automatically allocated when Lyric starts up. 

o Corrected board and pin designations listed in Duet Hardware for second and 
subsequent VGBs. 

o Existing GPI assignments will no longer be overwritten when Global GPIs are 
configured unless the global GPI is enabled. 

 Wipe Image Effect now supports a softness of 0 (none) 

 Correct error message posted if the source object for an object-textured image is not 
found.   

 Corrected scaling of graphics imported into 16 x 9 SD canvas when 1:1 aspect is 
disabled. 

 Corrected Save As cropping with Duet HD. 

 Macros/LEIF Corrections/Modifications:  

o Get/SetBackgroundVisible on Scene object now properly handles solid or 
gradated color background. 

o Improved error reported if a file cannot be loaded into an Image object. 

o MajorVersion and MinorVersion methods on Version object now return correct 
values. 

o Rect method on Template object now returns correct values if Canvas is scaled 
and/or 16:9. 

o Reversed operation of flag for SizeToFit method on Template object, which had 
been counter-intuitive 

o Resolved problem where saving a trigger macro twice to the same file would 
delete the file. 

o Simultaneously executing and recording macros is now prevented.  This conflict 
can occur when an Intelligent Interface E macro execution command is sent 
while a macro record is in progress. 

 Resolved kerning issues with a clock/timer on a 16 x 9 canvas on Duet LE/PCI systems. 

 Esc is no longer accepted as the Playlist Take hotkey. 

 Resolved problem where F2 would not delete remainder of row if preceded by Ctrl + 
Home. 
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 Resolved problem where Ctrl + Click selection of group members in Scene Graph 
would select objects outside of the group. 

 Corrected processing of characters typed with two keystrokes such as accented 
characters. 

 Resolved problem where a Playlist read from file would be erroneously updated with 
default parameter settings. 

 Disabled ability to move 4:3 reference Safe Title using the mouse. 

 Corrected Alpha of exported QuickTime movies. 

 Import of an image into a 2D Text Window will not wrap to the next line if Word Wrap is 
not enabled. 

 Fixed problem with the cursor not moving if 2D Frames On are off. 

 When in Preview Mode, if you try to add another node, you'll snap out of Preview Mode 
and the new node will start at frame 0. 

 If an image file is not found on load (e.g., during DBLink), the error is now posted to the 
Lyric status bar instead of in a message box. 

 Resolved crash when a second Lyric process exits on Duet LEX/PCI+ systems. 
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Known Issues 
 PCI-Squeezeback boards do not support Clocks/Timers. 

 A Clip with a Start Time of 0, 1 or 2 frames always starts at Frame 0 when the animation 
is executed.  A Clip with a Start Time of 3 or higher executes at the specified frame. 

 Clip Control Panel:  The minimum number of frames that can be looped to from the end 
of a clip is 15.  Output is unpredictable if the loop frame is set to less than 15 frames from 
the end of the clip. 
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